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Biological Neural Networks
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Donald O. Hebb, The Organization of Behavior (1949) ° The majority of neurons encode their

outputs or activations as a series of brief
electrical pulses.

Cell body
Axon Telodendria

e  Dendrites are the receptive zones that
receive activation from other neurons.

Y
Nucleus \

—

e  The cell body (soma) of the neuron’s
processes the incoming activations
(excitatory and inhibitory) and converts

Axon hillock ) Synaptic terminals them into output activations.

J‘\ ®  Axons are transmission lines that send

P,

L

— activation to other neurons.

Golgi apparatus e  Synapses allow weighted transmission of

signals (via neurotransmitters) between
The Brain: axons and dendrites to build up large
neural networks.

Endoplasmic
reticulum

Mitochondrion \\ \ Dendrite ~ 100 billion (10") neurons
\ ~ 100 trillion (10') synapses ®  All-or-one response: A higher stimulus
/ & Dendrifie branehes does not cause a higher response.
( \ — “binary classifier”
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McCulloch-Pitts Neurons
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McCulloch & Pitts, A Logical Calculus of the Ideas Immanent in Nervous Activity (1943)

nputs epe o .
e e Artificial neurons have the same basic

components as biological neurons.
weigwts

i

bias
The simplest Artificial Neural Networks
il (ANN) consist of a set of McCulloch-Pitts

wejgh‘te,cl unit step neurons.
Sum function
w1 k
[ J

o

output There is a threshold bias x,=1, w,=-0
s — = 1 o  Allows bias to be captured from
input neurons.
o  Allows normalization of output
w neuron thresholds without loss of generality.

T

n
y=sgn| wy+ Zw,-xi
i=1
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Perceptron
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Frank Rosenblatt, The perceptron. A probabilistic model for information storage and organization in the brain (1958)

An arrangement of one input layer of activations feeding forward to one
output layer of McCulloch-Pitts neurons is known as a simple Perceptron.

inputs weights outputs . .
¢ 7 e e Input layer with n inputsx ..., x .

e  Output layer of m McCulloch-Pitts

neuronsy,,...y with associated thresholds (91 - Qm.

e Eachinputx, is connected to each output neuron ijith an
associated weight W,

e For the training, each output Y, computed by the perceptron
will be compared with a desired outputd ,....d .

e Training a perceptron means adapting the weights w; until

{

they fit input-output relationships of the given ‘training data’.
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What the Perceptron can Do o

GFIZ Karlsruhe

Leibniz Institute for Information Infrastructure

Learning with a Perceptron

® |Initialize weights randomly

® Take one sample x, and predict y,

® For erroneous predictions update weights

o If the output was y = 0 and desired output d =1,
increase weights.

o If the output was y. =1 and desired output d =0,
decrease weights.

® Repeat until no errors are made.
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Perceptron (2)
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An arrangement of one input layer of activations feeding forward to one
output layer of McCulloch-Pitts neurons is known as a simple Perceptron.

inputs weights outputs

Information Service Engineering, Prof. Dr. Harald Sack

Network activation: for each neuron in output layer j=1,...,m

n
y; = sgn Zwijx,- — &)
i=1

Perceptron learning function:
for each feature weight Wi i=1,..,n of neuron in output layer j=1,..,m

Wij(l +1) = Wij(l) = AW,’j(l‘)
Aw; = n (d; — y;(0) x;

Leamir5 rate o\ee}ed \ac’fual
coefticient output output
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Perceptron Learning Algorithm oA
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Input vector x(t) = [+1, x, (1), x,(1), ..., x (O]

Weight vector w(t) = [-0, w (1), w,(D), ..., wn(t)]T , 0 = bias

Actual response y(t) (quantized)

Desired response d(t)

Learning-rate n,0<n<1
1. Initialization. Set w(0) = 0. Then perform the following computations for time-step ¢t = 1, 2, ....
2. Activation. At time-step ¢, activate the perceptron by applying

continuous-valued input vector x(?) and desired response d(?).

3. Computation of Compute the actual response of the perceptron as y(?) = sgn[wT(t) x(1)]
Actual Response.

4. Adaptation of Update the weight vector of the perceptron to obtain, where

Weight Vector. i
eight Vector Wt + 1) = W) + 1 [d) — (O] 50 () = +1 ?f x(¢) belongs to class ¢,
—1 if x(z) belongs to class ¢,

5. Continuation. Increment time step ¢t = t+1 by one and go back to step 2.
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Building an Artificial Neural Network
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Using artificial neural networks to solve real problems is a multi-stage process:

1. Understand and specify the problem in terms of inputs and required outputs.

2. Take the simplest form of network that might be able to solve the problem.

3. Tryto find appropriate connection weights and neuron thresholds so that the
network produces appropriate outputs for each input in its training data.

4. Test the network on its training data, and also on new (validation/testing) data.

5. If the network doesn’t perform well enough, go back to 3 and work harder.

6. If the network still doesn’t perform well enough, go back to 2 and work harder.

7. If the network still doesn’t perform well enough, go back to 1 and work harder.

8. Problem solved — move on to next problem.
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Decision Boundaries ﬂ
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® \We can use McCulloch-Pitts neurons to implement
the basic logic gates (e.g. AND, OR, NOT).

® Train network to calculate the appropriate weights
and thresholds in order to correctly classify the
different classes (i.e. form decision boundaries

between classes).
AND

x1 x2 y

Q 0 0 0
0 1 0 0

e 0 1 0
1 1 1
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The Problem with the XOR
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e However, the simple exclusive or (XOR) cannot be solved by perceptrons.
[Minsky and Papert, “Perceptrons”, 1969] =

XOR
X4 X, Y4 °
0 0 0
0 1 1
1 0 1
1 1 0
Ow, +0w,<0

0w1+1w2>9
1w1+0w2>9
1w1+1w2<9

Ll
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Multilayer Neural Networks
¢ FIZKarlsruhe

input Tout T e e .

I“PV:’-’ hidden layers E:‘/;: e The perceptron is limited to the classification of linearly

separable patterns. How can we make it more flexible?

e Solution:
o Use non-monotonic activation functions.

Z o  Use multilayer neural networks, which include at least
/NN \@ one hidden layer of neurons with non-linear

activations functions.

e Problem: Desired output for hidden nodes is not known

® New Learning Algorithm: Backpropagation Algorithm
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Backpropagation Algorithm
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Rumelhart, Hinton & Williams, Learning representations by back-propagating errors (1986)

;"P“t ou‘tpu’t

lorer hiddlen lavers layer ® (Forward phase

O  Synaptic weights of the network are fixed.

O Input signal is propagated through the network layer by layer,
until it reaches the output.

O  Changes only in activation potentials and outputs.

e Backward phase

/ o Anerror signal is produced by comparing network output with
desired response.

o Resulting error signal is propagated through the network layer
by layer in the backward direction.

o  Successive adjustments are made to the synaptic weights of
the network.

(1) p forward propagation

(2) = backward propagation
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?V\pu‘t ou‘tpu‘t

layer vidldlen layers layer ® The quality of your Machine Learning approach depends on the

appropriate assembly of the features used for learning.

e Feature engineering is the process of using domain knowledge of the
data to create features that make machine learning algorithms work.

e When working on a machine learning problem, feature engineering
is manually designing what the input x. should be.

e Coming up with appropriate features is
o difficult,
o time consuming, and

o requires expert knowledge.
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Towards Deep Learning

. hidden layer 1 hidden layer 2 hidden layer 3
input layer

N

output layer

KIT

Karlsruher Institut fur Technologie
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Deep Learning uses deep (multi layer)
neural networks (DNN).

Assume hidden layers with 1000 nodes
each.

In the given example, we need 2 Mio
parameters to optimize between the
hidden layers only.

To classify images or for object detection,
there would be no spatial invariance, i.e.
lack of generalization.
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About the Term “Deep Learning” e s
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“Representation learning is a set of methods that allows a
machine to be fed with raw data and to automatically discover
the representations needed for detection or classification.
Deep-learning methods are representation-learning methods

with multiple levels of representation [...]”

-- LeCun, Y., Bengio, Y., & Hinton, G. (2015). Deep learning. Nature, 521(7553), 436.
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Visual Analysis - Image Classification Tasks
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Challenges:

Viewpoint variation
Background clutter
Different Illumination
Occlusion
Deformation

Intra class variation

An image is a tensor of \
integers between [0, 255], )
ase.g. 800 x600x 3 \

(3 channels RGB) N

\
\

[[105
[ 91
[ 76
[ 99
[106
[114
[133
[128
[125
[127
[115
[ 89
[ 63
[ 62
[ 63
[ 87
[118
[164
[157
[130
[128
[123
(122
[122

148

93

153
119

99
69
72
112
92
69

87]
85]
85]
94]
95]
91]
82]
101]
98]
84]
78]
8e]
87]
119]
118]
112]
107]
109]
94]
86]
79]
99]
107]
84]]]

What the compu‘tef (‘e_a“y "sees”
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4. Basic Machine Learning / 4.8 Neural Networks and Deep Learning ﬂ(IT
Convolutional Neural Networks
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® CNNs are a special type of neural networks for processing spatially arranged data.
® CNNs are particularly adapted for visual analysis tasks.
e Fundamental building blocks of CNNs: convolution and pooling.

e
: | E E
Cat 6 weeks old, André Karwath aka Aka, edited bv, CC-BY-SA2.5 /// S E
convolution pooling convolution pooling
| ||
I I
feature learning classification

e Convolutional layer: feature extraction
® Pooling layer: compress and aggregate information, save parameters
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Convolution Layer
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Input Convolution Layer Weights Output Convolution Layer

® Purpose: examine (filter) the input from F/

different perspectives. o [ ,

B T ‘\\4;&‘

e Each neuron checks a specific area of the - T = .

input field using a filter kernel. .

. . . . T —l_ 2P g g Fp . V4

e Afilter examines the image for a certain - : .

feature, e.g. color, edges or brightness. - : .

i i Np

. The reSU|t Ofafilter iSthe Weighted inpUt :IllIIlllIIII1IIlllIllTIlll]!llTlll]ll:

of a range and is stored in the N o 2P

convolutional layer.
e The depth of the convolutional layer is | B Convolutional filter acts as a

= classifier for local features

defined by the number of filters.
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Pooling Layer

® Purpose: subsampling

e Information is compressed between the
individual convolutional layers via pooling
layers (dimensionality reduction), as e.g. by
simply taking the maximum.

® Pooling layers run through the feature maps
created by the filters and compress them.

KIT

Karlsruher Institut fur Technologie

GFIZ Karlsruhe

Leibniz Institute for Information Infrastructure

Input Pooling layer Output Pooling layer
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Transfer Learning e
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e Transfer Learning (TL): learning a new task depends on the previously learned task
e TL for Deep Learning: off-the-shelf pre-trained models as feature extractors
o  Fine-tuning off-the-shelf pre-trained models via supervised domain adaption

Replacing the
rd

?ulla-comec‘reo\ layer

=
-

+ [
LMW, Turner, Rain, Steam, and Speed, 14;‘, Public Doma\
convolution pooling convolution pooling
| [
I I
feature learning classification
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e Most deep learning architectures combine and recombine a limited set of architectural primitives
o Fully connected layers

Convolutional layers

Pooling Layers

Recurrent neural network layers

o O O O

Long Short-Term Memory Cells

ul Convolution
Pooling

I
aafaalaggig
|5

Information Service Engineering, Prof. Dr. Harald Sack, FIZ Karlsruhe - Leibniz Institute for Information Infrastructure & AIFB - Karlsruhe Institute of Technology



Leon A. Gatys, Alexander S. Ecker, Matthias Bethge:
A Neural Algorithm of Artistic Style. CoRR abs/1508.06576 (2015)

4, Basic Machine Learning / 4.8 Neural Networks and Deep Learning

From Classification to Generation

Style Adaption
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4. Basic Machine Learning / 4.8 Neural Networks and Deep Learning https://junvanz.github.io/CycleGAN/images/teaser_high_res.ipg

From Classification to Generation

Style Adaption

Monet > Photograph

e At ”
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From Classification to Generation

Cross Domain Transfer

https://junyanz.github.io/CycleGAN/
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From Classification to Generation
Super Resolution ‘:F.IZ. Karlsruhe
bicubic SRResNet SRGAN

~ (21.59dB/0.6423) (23.53dB/0.7832)

(21.15dB/0.6868)

y 3

https://arxiv.org/pdf/1609.04802.pdf
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From Classification to Generation

Image Completion

Model Input Completions Original

https://openai.com/blog/image-gpt/
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Text-to-Image GFIZ Karlsruhe
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TEXTPROMPT  an armchair in the shape of an avocado. an armchair imitating an avocado.

3
A
3
@

AI-GENERATED
IMAGES

Q
o=
e
Y }

OpenAl, DALL-E: Creating Images from Text (2021)

_d
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Generative Adversarial Networks (GANSs) CF{IZ. Karlsruhe
Discriminator B Training
____________________ RS > Set
1
TRUE '
L |
‘ 1 Real
| Images
|
FALSE !
1
_____________________ - /
Random J
--------------------- \\
\ Fake
Images

Schmidthuber, 1992
Niemitalo, 2010
Goodfellow, 2014

R
/:’"‘\‘
=4

— - - — -

_____________________ P
Generator /

https://towardsdatascience.com/generative-adversarial-networks-explained-34472718707a
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The Chinese Room Problem
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® Suppose you are placed in a room with a book of symbols and
instructions.

e When a symbol appears, the book tells you what symbols to
produce.

e To any outside observer, the room is able to perfectly answer
guestions in Chinese, but. . .

o Does the room know Chinese?

o Do you know Chinese? @ i v ¥
o Does the book know Chinese? ' o

® The same dilemma occurs ®
when we talk about machine learning...
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Neural Networks Notebook

Neural Networks at work GFIZ Karlsruhe
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& 12 - ISE2021 -Neural Networks.ipynb

B Comment 2% Share £
File Edit View Insert Runtime Tools Help Lastedited on28 June

+ Code + Text Connect ~ 2 Editing

i B A -~

- Basic Machine Learning - Basic Neural Network Applications

This is the colab notebook example for lecture 12: Basic Machine Learning 3, chapter 4.8 Neural Networks and Deep Learning, of AIFB/KIT
Lecture "Information Service Engineering” Summer Semester 2021.

In this colab notebook you will learn how to make use of the keras library as well as the SciKit Learn library for applying machine learning
algorithms, in particular for the multilayer neural networks, and mathplotlib to draw diagrams.

Please make a copy of this notebook to try out your own adaptions via "File -> Save Copy in Drive".

Please also don't forget to turn on GPU support for this notebook via "Edit -> Notebook Settings".

weather, i.e. will it be raining or not, for the next day from today's weather observations.

By then, we achieved the best results for weather prediction with Random Forests with an F1-score of 64.45%. Today, we want to find out, by
how far neural networks are able to challenge this result.

° # SciKit Learn helper functions
from sklearn.model_selection import train_test_split
from sklearn.metrics import accuracy_ score,confusion matrix

# for data analysis and manipulation
import pandas as pd

# Keras neural network model
from keras.models import Sequential
from keras.layers import Dense

# To plot pretty figures
$matplotlib inline

import matplotlib

import matplotlib.pyplot as plt
import seaborn as sns

Neural Networks Notebook

34
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4.1 A Brief History of Al
4.2 Introduction to Machine Learning
4.3 Main Challenges of Machine Learning
4.4 Machine Learning Workflow
4.5 Basic ML Algorithms 1 - k-Means Clustering
4.6 Basic ML Algorithms 2 - Linear Regression
4.7 Basic ML Algorithms 3 - Decision Trees
4.8 Neural Networks and Deep Learning
4.9 Word Embeddings
4.10 Knowledge Graph Embeddings
35
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Distributional Semantics

KIT

Karlsruher Institut fur Technologie
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"You shall know a word
| Bt/ the company t ke,e,ps."

e A word’s meaning is given by the words that frequently appear
close-by.

® When a word w appears in a text, its context is the set of words that
appear nearby (within a fixed-size window).

e Use the different contexts of w to build up a representation of w.

Though quite agile on land, capybaras are equally at home in the water.
A giant cavy rodent native to South America, the capybara actually is the largest living rodent.

\ These context words John Rupert Firth

will represent “capybara (1890-1960)

J.R. Firth (1957) A synopsis of linguistic theory, Studies in linguistic analysis, Blackwell, Oxford
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e We will build a dense vector for each word, so that
it is similar to vectors of words that appear in similar contexts.

0.286
0.792
-0.177
—-0.107
0.109
—0.542
0.349
0.271

capybara =

e Word vectors are a distributed representation. They are also referred to as
word embeddings or word representations.
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Word2Vec AT
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Overview

e Word2vec (Mikolov et al. 2013) is a framework for learning word
vectors.

® Operating Principle:

o We need to have a large corpus of text.

o Every word in a fixed vocabulary is represented by a vector.

o Go through each position 7 in the text, which has a center
word ¢ and context (“outside”) words o.

o Use the similarity of the word vectors for ¢ and o to calculate
the probability of o given c (or vice versa).

o Keep adjusting the word vectors to maximize this probability.

Mikolov, Tomas; et al. (2013). "Efficient Estimation of Word Representations in Vector Space". arXiv:1301.3781
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4. Basic Machine Learning / 4.9 Word Embeddings
Word2Vec T
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e Example windows and process for computing P(wt+j|wt)

...agile on land capybaras are equally at home ...

N AN J )
Y Y Y

outside context words center word outside context words

in window of size 3 at position ¢ in window of size 3

Mikolov, Tomas; et al. (2013). "Efficient Estimation of Word Representations in Vector Space". arXiv:1301.3781
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4. Basic Machine Learning / 4.9 Word Embeddings
Word2Vec T
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Overview ( FIZ Karlsruhe
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e Example windows and process for computing P(wt+j|wt)

..agile on land capybaras are equally at home ...
~ Y / Rf_/\ Y /

outside context words center word outside context words
in window of size 3 at position ¢ in window of size 2

Mikolov, Tomas; et al. (2013). "Efficient Estimation of Word Representations in Vector Space". arXiv:1301.3781
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4. Basic Machine Learning / 4.9 Word Embeddings
Word2Vec T
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® Foreach positiont =1, ..., T, predict context words within a
window of fixed size m, given center word w,

T
Likelihood= L(0) = [[ [] Plwpsjlws:0)

t=1—-j<m<j
0 is Al variables 70

to be optimized
P also referred to as

cost or loss function
e The objective function J@) is the (average) negative log likelihood:
1 | —
J(O) = —Flog L(O) = =5 > D log Plwiy|wi;)
t=1 —j<m<j
J#0
® Minimizing objective function == Maximizing predictive accuracy
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4. Basic Machine Learning / 4.9 Word Embeddings
Word2Vec T

Karlsruher Institut fur Technologie

Objective Function GFIZKarlsruhe
1 T
e Minimizing the objective function J(6) = _TZ > log P(wyj|wy; 0)
t=1 —j<m<j
j#0

e How to calculate P(wt+j|wt;0)?

e Idea: Use two vectors per word:
o v when w is a center word
o u, when w is a context word

e The probability that a context word o co-occurs for a center word c:

exp(u, ve)

P(olc) =

Zwe Vexp ulv,

Mikolov, Tomas; et al. (2013). "Efficient Estimation of Word Representations in Vector Space". arXiv:1301.3781
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4. Basic Machine Learning / 4.9 Word Embeddings
Dot eroduct ﬂ(l'l‘

Wo rd 2Ve c QXPonen*.a*bn *o cor(vares 3"“‘%““{3 Karlsruher Institut fur Technologie
Objective Function rf\ake QVQ“SH\.WE larﬁer C\O‘l‘ P“Odb\d‘ = G FIZ Karlsruhe
Pos‘“"‘ve B“&Q“ Probab“-‘*a Leibniz Institute for Information Infrastructure
T UTU — U U — Z U;V;
explu, v P
P (0 ’ C) — p ( o C) 1

ZweVeXp ugvc\ normalize over the
entire vocabular:.) Vv

e This is a softmax function R" — (0, 1)"

exp(z;) )
>ojiexp(z;)

softmax(x;) =

® The softmax function maps arbitrary values x_ to a probability distribution
12
o “max”: amplifies probability of the largest x.
o “soft”: also assigns (some) probability to smaller x,
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Variants

e Word2Vec maximizes the objective function by putting similar words nearby
in vector space.

e Two model variants:
o Skip-gram (SG):
Predict (sequence independent)

INPUT PROJECTION OUTPUT INPUT PROJECTION OUTPUT
context words given the center word.
w(t-2) w(t-2)
o Continuous Bag of Words (CBOW):
Predict center word from \s /’
(bag of) context words. / | ™ o > \
w(t+1) w(t+1)
w(t+2) / \ w(t+2)

CBOW Skip-gram
Mikolov, Tomas; et al. (2013). "Efficient Estimation of Word Representations in Vector Space". arXiv:1301.3781
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4. Basic Machine Learning / 4.9 Word Embeddings
Word2Vec T

Karlsruher Institut fur Technologie

Skip-gram & CBOW ) - F.'Z. Karlsruhe
g 8 Output layer Leibniz Institute for Information Infrastructure
0 o
: softmax is on :
O ;
e | output vector (R
o 9
Input layer
3 _Output layer N
0 0 0]
o o o)
o o 0
Xok ; <.> Y X o V2,
© © 9
: - V-dim V-dim _
0 0
o o
o o
Xcr A Yej
O/ CxV-dim o
CxV-dim
CBOW Skip-gram

Rong, X.(2014). word2vec parameter learning explained. CoRR, abs/1411.2738
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How to Evaluate? SUT
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Intrinsic Evaluation of Word Vectors CFIZ Karlsruhe
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e Word Vector Analogies

~
r_~

T
a:b::c:d —» d = argmax (xb Ta + xC) Ly 1
& “xb_xa+xc||

man : woman = king : ? 0.5+ /’ R
o ;

kn
e Evaluate word vectors by how well their 0.5- I

cosine distance after addition captures
intuitive semantic and syntactic analogy '/;MM
questions. 0.a5+  *
e Discarding the input words from the search!
e Problem: What if the information is there ‘ ‘ : :
but not linear? 0 0.25 05 075 1

~
-
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4. Basic Machine Learning / 4.9 Word Embeddings

Word Embeddings Notebook

Word2Vec at work

& 12 - ISE2021 -Word Embeddings.ipynb
File Edit View Insert Runtime Tools Help Last edited on 18 June

+ Code + Text

Basic Machine Learning - Word Embeddings

This is the colab notebook example for lecture 12: Basic Machine Learning 3, chapter 4.8 Word Embeddings, of AIFB/KIT Lecture "Information

Service Engineering" Summer Semester 2021.

In this colab notebook you will learn how to make use of the SciKit Learn and the gensim library for applying machine learning algorithms, in
particular for the word2vec (and other) word embeddings, and mathplotlib to draw diagrams.

Please make a copy of this notebook to try out your own adaptions via "File -> Save Copy in Drive"

veo R/ E

[ 1] #First loading all necessary libraries
gmatplotlib inline
import urllib.request
import gensim
import gensim.downloader as api

# to visualize word vectors
from sklearn.manifold import TSNE
import matplotlib.pyplot as plt

‘D #helper function to draw a TSNE diagram of a word vector space
def plot_word_embeddings(model, search_list):
words = []
for term in search_list:

words += [w[0] for w in model.most_similar([term], topn=5)]

words += search_list

vectors = model[words]

tsne = TSNE(n_components=2, random state=0, n_iter=10000, perplexity=7)

T = tsne.fit_transform(vectors)

Word Embeddings Notebook

KIT

Karlsruher Institut fur Technologie

GFIZ Karlsruhe

Leibniz Institute for Information Infrastructure
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4. Machine Learning € riz artsruhe
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Information Service Engineering A\‘(IT

4.1 A Brief History of Al
4.2 Introduction to Machine Learning
4.3 Main Challenges of Machine Learning
4.4 Machine Learning Workflow
4.5 Basic ML Algorithms 1 - k-Means Clustering
4.6 Basic ML Algorithms 2 - Linear Regression
4.7 Basic ML Algorithms 3 - Decision Trees
4.8 Neural Networks and Deep Learning
4.9 Word Embeddings
4.10 Knowledge Graph Embeddings
48
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4. Basic Machine Learning / 4.9 Knowledge Graph Embeddings

Semantic Similarity

From Words to Entities

e For Word Embeddings, words with similar meanings are mapped
to close vectors in a vector space.

e How can we map this concept to Knowledge Graphs?

e When are two nodes (entities) semantically similar?
o If they can be described by the same/similar facts, as e.g.

m Carbon Dioxide is a Greenhouse Gas and
water vapour is a Greenhouse Gas,

B Obert Einstein is a ’Phgs\c\s’r and
S+ephen Haw\dnﬁ s a ’Phﬁs\c\s’r.

m s Steghen Hawkm more similar to Albert Einstein or
to Carbon Dioxide?

Information Service Engineering, Prof. Dr. Harald Sack, FIZ Karlsruhe - Leibniz Institute for Information Infrastructure muwemsmcmmmome
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Semantic Similarity S
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Jan Baptist

van Helmont -
Chemical Physicist

Ulm

— C'ar‘b'on I Gas 4 Water Vapour Stephen Alberﬂ‘:
Dioxide \_/ Hawking Einstein
Person 4 Mlleya
Maric
Acidic Greenhouse \_/
Oxide Gas

Birth place
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Semantic Similarity S
" FIZ Karlsruhe

Leibniz Institute for Information Infrastructure
Jan Baptist

van Helmont Physicist

Chemical

Ulm

Stephen Albert

Carbon
Gas Water Vapour Hawking Einstein

Dioxide \\\\~___’///

Mileva

\\MTC/

Person

Greenhouse
Gas

Acidic
Oxide

Birth place

o Carbon Dioxide and Water Vapour share similar (structural) context in the graph.
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Semantic Similarity

Jan Baptist
van Helmont

¢ Carbon

Dioxide

Acidic
Oxide

“/

Chemical

Gas

Greenhouse
Gas

Water Vapour

KIT
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Physicist

Stephen Albert
Hawking Einstein

Mileva

wc/

Person

Birth place

o Stephen Hawking and Albert Einstein share similar (structural) context in the graph.
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Semantic Similarity

Jan Baptist \f

van Helmont

Chemical

Carbon Gas

Dioxide \/

Acidic Greenhouse

Woxj-de(

Water Vapour

\%

o "ou shall know a node by the company it keeps',

KIT

Karlsruher Institut fur Technologie

c:FIZ Karlsruhe
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Physicist

Stephen Albert
Hawking Einstein

Person — G

Birth place

i.e. similar nodes can be identified by having the same/similar neighborhood (context)

» Distributional Semantics
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Graph Embeddings

GF'IZV Karlsruhe
(Knowledge) Graph Representation Vector Space Representation
o0 s

. B ¥ ko .‘ 7 & 1
. 08l @g g ® °o® .
& 7 ' 29 g @ 17
' -1.0} 3 a L %

&
\ 1.2} @ L

—e P 2
—1.4f .
—-1.6| |
= 2

= e _1.8 i . 1 1 1 1 L 1 |

1 1
-1.0 -0.5 0.0 0.5 1.0 1.5 2.0 2.5

Idea: Find embedding of nodes in a low-dimensional vector space
so that “similar” nodes in the graph have vector embeddings that are close together.
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Knowledge Graphs are more than just plain Graphs S
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® Besides entities (nodes), we also want to represent
o Properties and property relations

Hierarchies and inverse properties
Symmetry and antisymmetry
Reflexivity and irreflexivity
Functionality and inverse functionality

Transitivity

o Literals
m Multimodality (text, numbers, images, etc.)
m Datatype semantics
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Knowledge Graph Embe¢

High score =
high chances for the

uction Kit SKIT

Karlsruher Institut fur Technologie

Pact (5,0,0) to be true (F.IZ._Karl,sruhe o
e
@ Scoring Layer f{s,p,0) €ER
Optimizer """ ® Training
: R¥
Lo ¢ O [MTTTTTTTT11]
Q /’Q“‘*”“ O [TTTTTTTTT] Downstream Tasks
/ '\worksFor Do basedin City George (Llnk Prediction)
worksFor ikes—s(( A Scoring Layer Loss Y
_ - Lookup il . Functions O I ] I I l l l I I I I
[ scnsi Wik, SV gt Layer f(spo)ER £ o f(s,p,0) ER
O‘(\M\A\_z) : L
Cooe Person —likes—>
LITTTTTTIT] .
@ Knowledge Graph G i
Negatives Generation

®) Loss Functions £

® Inference
@) Negatives Generation

Pays a penal‘tt./ R
score of positive 'triple
less than score of
synthetic negative

Create "Qormpteo(" versions
of existing ‘tﬁples
as ne_go:tive_ ‘tﬁple_s
Information Service ERg

Costabello, L. et al, ECAI-20 Tutorial: Knowledge Graph Embeddings: From Theory to Practice, 2020
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Knowledge Graph Embeddings
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Many ways to generate Knowledge Graph Embeddings:

e Translational Methods: TransE, TransH, TransR, TransEdge, ...

e Semantic Matching: RESCAL, DistMult, HolE, ComplEx

® Graph Convolutional Networks: R-GCN, TransGCN, ConvE, ConvR, ConvKkB
® RelationPaths: PTransk, DeepWalk, RDF2Vec
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Knowledge Graph Completion - Link Prediction
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Task Example Result
Triple Classification (JosephFourier, occupation, physicist)? (yes, 95%)
Tail Prediction (JosephFourier, occupation, ?) (1, physicist, 0.95),

(2, chemist, 0.93) ...

Link Prediction

(Type Prediction)

Head Prediction (?, occupation, physicist) (1, AlbertEinstein, 0.91)

(2, StephenHawking, 0.90)
Relation Prediction (JosephFourier, ?, physicist) (1, occupation, 0.95)
Entity Classification (JosephFourier, isA, ?) (1, Person, 0.99)

(2, Human, 0.99),...
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4. Machine Learning € riz artsrune
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4.1 A Brief History of Al

4.2 Introduction to Machine Learning

4.3 Main Challenges of Machine Learning

4.4 Basic ML Algorithms 1 - k-Means Clustering
4.5 Basic ML Algorithms 2 - Linear Regression
4.6 Basic ML Algorithms 3 - Decision Trees

4.7 Neural Networks and Deep Learning

4.8 Knowledge Graph Embeddings

4.9 Knowledge Graph Completion
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Lecture Overview (F'ZKarlsruhe
1. Information, Natural Language and the Web
2. Natural Language Processing
3. Linked Data Engineering
4. Basic Machine Learning
5. ISE Applications
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Bibliography GFIZKarlsruhe
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S. Marsland, Machine Learning, An Algorithmic Perspective, 2nd. ed.,
Chapman & Hall / CRC Press, 2015.

o  Chap. 3 (Neural Networks)
(The book should also be available on the Web as pdf, just keep looking...)

Word Embeddings:
Mikolov, Tomas; et al. (2013). Efficient Estimation of Word Representations in Vector Space.
arXiv:1301.3781

Knowledge Graph Embeddings:
Wang et al., Knowledge graph embedding: A survey of approaches and applications. |EEE
Transactions on Knowledge and Data Engineering (TKDE), 2017.

(if you want to deepen your knowledge beyond the scope of the lecture...)

61

Information Service Engineering, Prof. Dr. Harald Sack, FIZ Karlsruhe - Leibniz Institute for Information Infrastructure & AIFB - Karlsruhe Institute of Technology


https://en.wikipedia.org/wiki/ArXiv
https://arxiv.org/abs/1301.3781

4. Basic Machine Learning - 3 ﬂ(".
Syllabus Questions Crzrsune

How does a Biological Neural Network work?

Explain the McCulloch Pitts Neuron model.

Explain a Perceptron.

Why can’t a Perceptron solve the XOR problem?

What are the limitations of Deep Neural Networks?

How to Convolutional Neural Networks overcome (some of) the problems/limitations of Deep

Neural Networks?
Explain Word Embeddings.
Explain Graph Embeddings.
e What is Knowledge Graph Completion?
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